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1 Introduction  

Phontage is a multi-media communication tool using a PC based application to link the operation 

of an on-screen multi-button telephone with other communications-related PC applications.   

Phontage is a PC desktop application that interfaces with the user via the mouse and keyboard.  All 

the features of the LG-Ericsson IP Phone are available to the User.  In addition, a Phonebook 

database with links to the Userôs Personal Information Manager (PIM), provides pop-up windows 

for incoming Caller Identification (Caller ID).  Phontage users can employ the Phonebook to place 

calls as well as manage contact records. File Sharing allows multiple parties in a conference to view 

and manipulate files simultaneously.  Other special functions available to Phontage Users include: 

Appointment scheduling, SMS support, Email and Call recording. 

The Phontage application is available in three versions: Basic, Pro, and Deluxe.  The Basic version 

provides a standard feature set.  The Pro version supports the Basic feature set and additional 

features such as video, conferencing, etc.  The Deluxe version includes the Pro feature set and adds 

recording and collaboration functionality.  The following chart lists the features and functions of 

each version: 

NOTEðThe Basic version is supported on all Call Servers (ipLDK/iPECS), the Pro version (Korea 

version only) is supported on all Call Servers except iPECS LIK, CM and MG, and the Deluxe 

version is supported on the iPECS LIK, CM and MG Systems.
 

 

BASIC PRO (Korea only) DELUXE  

 All Basic Features Plus All Pro Features Plus 

Login with ID and Password Video Conference, 2-party Voice Mail Backup and Management 

Local/Remote Connection Mode Video Data On/Off Status 3rd party Conversation Recording 

*Flexible Buttons (24) Outlook Call Popup with Exchange Server Auto Call Recording including 3rd Party 

Multi -language support *Conference Management File Collaboration (Application Sharing) 

Call By Name Transparent Main Window function Internal Instant Messaging (IM-Chatting) 

*User SMS (Short Message Service) Call Assistance Window *Flexible Buttons (48) 

Automatic Database Synchronization Favorite Contact Dialer LDAP Search 

Incoming Call Pop-up window Smart Recent Call List *Dynamic Group Call 

Hotkey Support   

Database Import/Export   

User Connection Profiles   

Smart Tray Icon & Menu   

Quick Call Menu   

Simple Dial-pad pop-up   

Display Mode (Clock, Calendar)   

Phone Book Calling   

Phone Book Management   
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BASIC PRO (Korea only) DELUXE  

 All Basic Features Plus All Pro Features Plus 

Scheduled Dial and Notification   

User Call Log management   

E-mail with Outlook   

Simple Favorites Contact List   

*IP Bridge   

*Fixed Line SMS   

Audio Tuning Wizard   

*Preference Codec Selection   

Hook Switch Setting   

   

NOTEðFeatures marked with * may have minor differences depending on which System is used. 

 

1.1 User Programming and Limitations 

The Phontage generally operates in the same manner as a traditional LG-Ericsson IP Phone.  

There are, however, several user-programmable functions which are not supported due to 

differences in the platform (i.e., PC versus IP Phone).  The user-programmable functions not 

supported by Phontage include: 

Á Station Answer mode ï Does not support Intercom Call Announce; supports only 

Privacy for the Station Answer mode. 

Á Station Ring Download ï Can not download ring tone files from the System, 

however, the Phontage User can change ring tone files stored in the Phontage 

folder (refer to Section 5.1.2.9). 

Á Audio source control ï A single audio path is only available and thus cannot 

support the dual path (headset and speaker) controls available with the traditional 

LG-Ericsson IP Phone. 

Á Call Recording ï Only one call can be recorded at a time. Likewise, 3
rd
 Party recording should 

not be used because it will have an effect on the recorded speech. 
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2 Installation and Setup 

Set-up of the Phontage is a four step process: 

1. Connect the PC to the Host System. 

2. Install the Phontage application on the User PC. 

3. Install system lock key. 

4. Login to complete System registration of the Phontage. 

Completing the login and registration process may require assistance from the system administrator 

to adjust any necessary settings.  The System will require a User ID and Password.  Also, for 

remote users, Phontage will require entry of the host System IP Address. 

Prior to installation, the PC and operating system should be verified for compatibility with the 

Phontage application.  Assure that the PC and Operating System (OS) comply with the minimum 

requirements of the following Sections 2.1 and 2.2. 

2.1 System Requirements 

The minimum requirements for the Phontage PC are described below. 

Á Pentium 4 or compatible CPU 

Á 1 GHz clock speed or higher 

Á 256 Mbytes RAM  

Á 200 Mbytes of free hard-drive space 

Á 1024 x 768 resolution monitor 

Á CD-ROM drive  

Á Video/Web cam, only required for real-time video 

Á USB Headset (Recommended) 

NOTEðVoice quality may differ depending on the type/brand of headset used. 

 

2.2 Supported Operating Systems 

Phontage can run under any one of several Microsoft Operating Systems including: 

Á Microsoft Windows Vista, 7 

Á Microsoft Windows 2003 

Á Microsoft Windows XP Home 

Á Microsoft Windows XP Professional. 

Á Microsoft Windows 2000 Professional 
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2.3 System Connection 

A PC running the Phontage application may be connected to the System either as a local or 

remote device.  Connecting as a local device requires Phontage connect to the same LAN as the 

host System.  When connecting as a remote device, the User ID and Password must be pre-

registered in the System database (refer to 2.6.2 for remote operation set up information). 

Figure 2.3 illustrates the connections to the System. 

 

Figure 2.3 Phontage Connections 

 

2.4 Application Installation 

When the Phontage CD-ROM is added to the CD-

ROM drive of the PC, an auto-execute program will 

start and the install Wizard should appear. 

To install the Phontage Application, perform the 

following Steps: 

1. At the InstallShield Wizard screen for 

Phontage, click on the Next button. 
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2. Enter the User Name and Organization; this 

information will be stored in the 

Help>About screen of the application as it is 

installed on your PC. 

 

 

 

 

 

3. Click on the appropriate radio button 

to select your Phontage license type. 

NOTEðThe Pro version is available 

in Korea only. 

 

 

 

 

 

4. The Destination folder for the 

Phontage application can be 

modified by clicking on the 

Change button (shown).  The 

default directory is recommended; to 

continue click on the Next button. 

 

5. Phontage install wizard will 

complete the Phontage application 

installation. 

 

 

2.5 System Lock-key  

Prior to registration of the Phontage with the host System, the host System will require 

installation of the Phontage software lock-key.  This can be accomplished by the System 

administrator (refer to the System Admin. Manual for detailed instructions). 
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2.6 Login & Registration  

2.6.1 Login 

To start the Phontage application: 

1. Select the Phontage shortcut icon,            , to start the Phontage application and display the Login 

window. 

 

2. In the Login screen, enter User ID 

and Password, and check any of the 

option boxes to automate login and/or 

enter a desired Station number which 

the system will use for you if the 

number is available (not supported on 

ipLDK System). 

 

3. In addition to Login information, the Login screen can be used to access the Network Setting 

screen for defining the device environment (refer to the following Section 2.6.2). 

 

2.6.2 Network & Profile Setting 

Network Settings, accessed via the Login screen, define the 

Profile Name, Connection Mode (Local or Remote), and the IP 

address of the host system.  To modify Network Settings: 

1. Select Network from the Login window. 

2. Select Local or Remote mode. 

3. Enter the System IP address for remote connection. 

In Local mode, if the System IP Address is blank, Phontage wil l 

use multi-cast discovery messages to locate a host. 

 

Defined Profiles can be selected from the drop-down list or 

added/edited/deleted with the Profile Name Tool icons: 

1. Select Profile Name. 

2. Click on the Add or Edit icon in the Network Setting 

screen. 

3. Enter the User ID, Password, and Connection mode. 

4. Enter the IP address of the host. 

5. Select OK. 
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2.6.3 Registration Process 

Auto registration (iPECS System Only) 

When the Phontage application is run for the first time, it will attempt to register to the iPECS 

System with the Userôs ID and Password.  When locally connected, the initial registration is 

automatic assuming the system is set to allow registration (refer to the System Installation 

manual for Registration Switch settings). 

Manual registration (All Systems) 

When the Phontage is remotely connected or the System is not set to allow new registrations, the 

Network settings must be changed from the Login screen.  The connection mode (Remote) and 

the System IP address must be entered (refer to Section 2.6.2).  In addition, the User ID and 

Password must be registered with the system in the Station User Login program. 

 

2.7 Connection Helper 

Connection Helper screen will be shown when the selected Network Adapter IP address is empty 

(0.0.0.0). Connection Helper allows the User to enter another NIC to login properly. 
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3 Phontage Overview 

 The Phontage Main screen is shown below.  The Main screen is divided into several elements to 

provide a simple and effective User interface.  Each element is briefly discussed in this section, and 

discussed in more detail in subsequent sections. 

 

3.1 Application Menu bar 

The Application Menu bar includes File administration, View screen selection, Tools access and Help 

access menus. 

3.2 Quick Call Menu bar 

Using these menu selections the user can place a call by pre-dialing a number with a mouse in the 

Simple Dial-pad pop-up, selecting a party from the Smart Recent Call list or the Simple Favorites 

list or using the PC keyboard to enter a number or Phonebook name. 

3.3 Simple Favorites List 

The User can populate the Simple Favorites list with commonly used names and numbers.  Using 

the PC mouse to select a list item and the handset icon will place a call. 

3.4 Info & Video Console 

Icons at the top of the Info & Video Console maintain a count of Voice Messages and SMS 

messages not heard or read, as well as a count of missed calls.  The icons may be used to quickly 

access the Message Lists screen. 

The Console displays either the time of day or a monthly Calendar, which will show appointment 
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dates in bold ink.  The Calendar links to Outlook scheduler allowing appointments to be added or 

modified from Phontage. 

The Record button can be used to record a conversation and store the recording on the local PC 

hard drive.  The recording can be reviewed, sent as an E-mail attachment with a commentary or 

deleted.  

The Phontage supports Video communications with an automatic link to a standard PC camera.  

Activate the video camera using the Video button for a preview, then open the channel to send real-

time video to the remote party.  As an additional convenience to business Users,  files may be 

shared in a collaborative multi-party conference session; each party has access to and can edit the 

application file over the Phontage link.  Select the Application Sharing icon, then select from the 

open file list.  The file is opened and displayed to all parties.  Any of the parties may manipulate the 

contents in real-time with the Handover function.  

NOTEðApplication Sharing is only available on the iPECS System. 

 

3.5 Basic Call Control Menu bar 

The Basic Call Control Menu bar includes separate slide volume controls for the speaker and 

microphone as well as Transfer, Conference, Hold and Speaker buttons.  In addition, on the far left 

the Text Message button will access SMS and IM screens. 

NOTEðIM Window is only available on the iPECS System. 

 

3.6 Window View Icon Menu bar 

The Phontage Window View Icon Menu bar opens the various Phontage optional windows such as 

the Phonebook, Call Log, Schedule Dial, IP Phone, Flex button, etc.  The Phonebook screen 

displays information on contacts registered in the Contact Manger database.  The fully-searchable 

and sortable Phonebook can be used to place calls and send e-mails.  The Phonebook database can 

be imported from and synchronized with an external source database each time the Phontage 

application is opened.  Also, modifications made to the Phonebook database can be automatically 

exported to the external database to maintain synchronization. 

The Call Log screen maintains a database with a record of each call placed or received by the 

Phontage.  The Call Log, if enabled, can be viewed, sorted and printed or it can be disabled so no 

log records are generated. 

The Recorded Call List screen gives access to tools allowing the User to manage calls previously 

recorded.  Recordings can be played, sent as an E-Mail attachment, deleted, etc. 
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In the Scheduled Dial screen the User can input a Phone number and a Date & Time to call the 

number; at the scheduled time the system will confirm and place the requested call. 

The IP Phone and Flex Button screens allow the User to interface with iPECS in the simple and 

convenient operation of a traditional LG-Ericsson IP Phone. 
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Simple 
Favorites List 

4 Quick Call Menu bar 

 

 

 

 

 

4.1 Placing a Call 

Placing a call with the Quick Call Menu is quick and efficient.  For your convenience, a number of 

calling options are available. 

To place a call: 

Simple Dial-pad pop-up 

1. Click the Dial-pad icon to open the Simple Dial-pad 

pop-up. 

2. Use the mouse to click and enter digits in the pre-dial 

box. 

3. Click on the Call button to initiate the call. 

 

Smart Recent Call list 

1. Click the drop-down list arrow of the 

pre-dial box to view the Smart Recent 

Call list. 

2. Select the desired entry. 

3. Click on the Call button to initiate the 

call. 

 

Simple Favorites list 

1. Double-click an entry in the Simple Favorites list to initiate a 

call. 

 

 

 

 

 

Simple Dial-pad 
pop-up control 

Drop-down arrow 
in Pre-dial box 
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PC Keyboard dialing 

1. Use the PC keyboard to enter digits or type a name 

listed in the Phontage Phonebook; entries will appear 

in the pre-dial box as entered. 

2. Click on the Call button (shown) to initiate the call. 

 

Phonebook or Call Log screens 

1. Calls can be placed directly from the Phonebook or Call Log screens by selecting a list entry. 

2. Click on the Call button. 

 

IP Phone screen 

1. Opening the IP Phone screen also will permit placing calls as with any Call Servers terminal. 

 

From Other Applications 

Calls can be placed from other applications while the Phontage is active or minimized.  To place a 

call from another application: 

1. Copy the desired digit string (Ctrl + C) 

2. Press the ñCtrl + Shift + Dò. 

 

4.1.1 Terminate Calls 

To terminate a call: 

1. Select the Telephone icon from the Basic Call Control Menu bar. 

 

4.2 Receiving a Call 

When a call is received, the phone will óringô and the selected Caller Information pop-up screen 

will display (refer to Section 5.1.2.7). The screen will show the Caller ID delivered from the 

System and the name referenced from the Phonebook database.  If Phontage is minimized, the 

Caller Information screen will pop-up to display the incoming call information or the Phontage 

icon in the Windows tray will flash to indicate the new call (in this case, Phontage must be 

opened to answer the call). 
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To answer a call with Phontage active: 

1. Click on the Telephone icon from the Basic Call 

Control Menu bar. 

 

To answer a call with Phontage minimized: 

1. Click on the Telephone or Phontage icon from the Caller Information pop-up screen (press the 

Enter key or Space Bar as a short-cut. Refer to 5.1.2.7 Popup & Outlook for detail). 

 

 

 

 

 

To terminate a call: 

1. Click on the Telephone icon from the Basic Call 

Control Menu bar (press the Enter key or Space Bar 

as a short-cut. Refer to 5.1.2.7 Popup & Outlook for 

detail). 

 

 

4.3 Enblock Dialing 

Phontage supports Enblock Dialing. So, a dialing number is quicker than overlapping dial. 

 

NOTEðiPECS LIK P5, CM or MG  is needed for this feature. 
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5 Application Menu bar  

 

 

 

5.1 File 

Selecting File from the Application Menu bar will display the File menu 

selections. 

 

 

 

 

5.1.1 Logout 

The Logout item wil l terminate the User 

connection to Phontage and will display the 

Login screen.  Closing the Login screen will 

then terminate the Phontage application. 

Checking the Desired Number box will allow 

entry of a preferred station number (if 

available) for your Phontage. 

NOTEðDesired Number is only available on the iPECS LIK system. 

5.1.2 Setting 

The Setting item will display a sub-menu where the User can determine the Connection Mode, 

Language, Dialing rules, Ring tone, etc. 

NOTEðThe ipLDK system only supports the Remote 

Connection mode. 
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5.1.2.1 System Connection 

The Phontage can be registered to a System in Local or Remote Mode.  In the Remote Mode, 

Systems will allocate a VoIP channel to support the call.  The VoIP channel will implement 

Network Address & Port Translation (NAPT) 

compatibility and packet forwarding to internal 

appliances. 

Selecting System Connection will display the 

System Connection screen with the present mode 

checked (Local or Remote).  When either mode is 

selected, the Phontage will terminate and re-connect 

with the host System to establish the selected 

connection mode.  Also in this screen, the host 

System IP address and a Network Adapter Ethernet 

MAC address can be entered or selected. 

 

5.1.2.2 Password Change 

Selecting Password Change will display the Change 

Password screen.   To change the password: 

1. Type in the correct Current Password. 

2. Type in the desired New Password. 

3. Type in the desired new password again in the 

Confirm New Password box. 

4. Click on OK to save changes. 

NOTEðiPECS system only. 

 

5.1.2.3 IP Bridge Mode 

IP Bridge Mode can be enabled under the File ï 

Setting menu (shown) for when the Phontage is 

linked with IP Phone. After dialing a number with 

Phontage and then lifting IP Phone Receiver, the 

voice path will be changed to IP Phone Receiver 

automatically.  

 

NOTEð iPECS LIK P5, CM or MG is needed for this feature. 
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5.1.2.4 Preference Codec Selection 

Phontage now supports G.711, G.723 and 

G.729 with iPECS LIK P5, CM or MG 

System. With Phontage, the User can select 

a preference codec: 

1. From the File menu, select 

Setting>Preference Codec. 

2. Select the applicable codec to be 

applied to the System Web Admin. 

(verify using PGM 132). 

 

 

5.1.2.5 Language 

Phontage supports multiple languages, English is the default and a Local Language can be 

designated.  The Local Language is translated from English and edited into the 

ólanguage.txtô file located in the Phontage program directory.  For additional help, access the 

ólanguage.txtô text file in the Phontage folder. 

Selecting Language will display the English/Local Language selection box with the present 

mode checked. When selecting the desired language, the Phontage will automatically change 

all text and messages to the desired language. 

 

5.1.2.6 Dialing Rules 

When placing an outside call from the Phonebook or Call Log screen, Phontage must 

include or remove certain dial codes to assure proper 

dialing through the System. When a number is selected 

from either screen, the system will compare the number 

to the dialing rules codes.  The dialing rules country 

and area codes are compared to the number and if 

matched are deleted from the number.  If not matched, 

the appropriate LD or International codes are inserted 

(preceded by the PBX and CO or IP line access codes).  

Codes are entered in the Dialing Rules dialog box, 

along with local codes for comparison. 

 

To enter Dialing Rules codes: 

1. Select Dialing Rules from Setting sub-menu. 
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2. Enter the appropriate codes. 

3. Click on the OK button. 

NOTEðFor proper operation, Phonebook entries should follow normal conventions. 

Ex., 

ñ+country code (area code) numberò [+82 (031) 450-4636] 

 

5.1.2.7 Popup & Outlook 

When an incoming call is received, Phontage will 

provide one of several Caller ID pop-up screens.  In 

addition, the pop-up can be displayed for an outgoing 

call.  The selection of a pop-up and when a pop-up is 

displayed is assigned in the Popup & Outlook screen. 

NOTEðThe ñMulti-callò type pop-up provides 

added information for DID Call types. 

To define Pop-up use: 

1. Select Popup & Outlook from the Setting sub-menu. 

2. Select the desired Pop-up; popup selections include Phontage Simple, Graphic and Multi-Call 

or the Outlook Contact screen (shown). 

 

 

 

 

3. Select the desired Pop-up Timing. 

4. Select OK. 

 

 

The Outlook pop-up is normally 

employed for external calls but can also be used for internal calls by selecting Internal Call in 

the Popup & Outlook screen. 

NOTEðOutlook contacts must include Internal Users to display the proper contact 

information. 

NOTEðENTER/SPACE Key will be disabled on each pop-up while an option, óEnable 

ENTER to answer or drop a call, is unchecked. 



ECS                 Phontage Desk-top Installer & User Guide 

 

 5-5 iss. 3.0 

 

5.1.2.8 Call Log (On/Off) 

Phontage can maintain a list of all 

calls to the phone.  Selecting Call Log 

from the Setting sub-menu, will 

display the On/Off selection box with 

the present mode checked. When 

enabled, the Call Log is available for 

viewing and use. 

 

 

 

 

 

5.1.2.9 Differential Ring 

The Phontage comes equipped with 4 ring files for notification of internal and external calls.  

Each ring file is a .wav encoded audio file. The User may select the ring tone from one of 

these files or upload a .wav type file for audible alerting. 

NOTEðStandard .wav or .mp3 files are supported.  Supported .wav files should be 8 or 16 

bit encoding, mono or stereo, at 8.0, 11.025, 22.05 and 44.1 KHz sampling. 

 

Selecting Differential Ring from the Setting sub-menu will open the Bell Sound screen.  To 

change a Ring tone file: 

1. Click on the spyglass icon next to file to be replaced. 

2. Select the desired .wav or .mp3 file from the PCs file system, and click on the Change button. 

3. Click on the Listen button to hear the selected ring tone. 

4. Click on the OK button to close the Bell Sound. 

 



ECS                 Phontage Desk-top Installer & User Guide 

 

 5-6 iss. 3.0 

 

To select a Ring Tone for use: 

1. Open the IP Phone window (refer to Section 9.7). 

2. Click on the PGM fixed feature button. 

3. Dial 1 for Ring Tone Selection. 

4. Dial 1 for Intercom Ring, or 2 for CO/IP ring. 

5. Dial the desired Ring Tone (1-4); a short burst of the tone will be heard. 

6. Click on the SAVE button. 

NOTEðipLDK supports Ring 1 only 

 

5.1.2.10 Audio Control 

Phontage can control the sound device employed.  

Select a Speaker for playing back Ring/DTMF and 

select a Speaker and a Microphone for 

communication. The Speaker can be defined 

separately for voice and ring signals. Selecting the 

Audio device drop-down menu will display the 

device choices available. 

 

 

 

 

5.1.2.11 Hook Switch Setting 

Hook Switch Setting provides remote-hook 

for answering or dropping a call using one of 

several Headsets. The supported Headsets 

include: 

1. Audio 910 Headset 

2. CS 50/60 USB Headset 

3. GN8120 Headset 

 

Headsets have different remote-hook switch 

and functions. To use one of the listed 

headsets with Phontage, refer to the Manual 

packaged with the headset. 

 


































































